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INTRODUCTION

WORD CHALLENGE is a sophisticated new word game designed especially
for your Macintosh. Word games are a long-standing tradition in Western
culture and now WORD CHALLENGE presents you with LEX, an electronic
opponent of uncanny skill and intelligence. Test and improve your vocabulary
skills by playing against LEX either alone or with your friends.

WORD CHALLENGE is easy to operate and fun to play. A variety of unique
options allows you to construct a game suitable to your own competitive level.
This user's manual provides step-by-step instructions and a detailed
explanation of the special features in WORD CHALLENGE. Special sections at
the end of the manual describe the inner mechanisms of the game and suggest
tips for the beginner.

The Word Challenge Cast of Characters

e LEX The expert and your opponent. LEX plays at
26 ditferent difficulty levels and is a match
for anyone from beginner to pro.

e YOU The challenger.
e Timer Set it to the amount of time YOU need.
¢ Scorekeeper Keeps track of games and match totals.

Choose among five scoring methods for the
Scorekeeper to use.

¢ Dictionary of The Scorekeeper’s reference for checking
90,000 Words all the words YOU and LEX discover.



PLAYING WORD CHALLENGE

OBIECT The object of WORD CHALLENGE is to compete
against LEX, the dreaded Word Master, to find
hidden words in a grid of letters. The player who
accumulates the most points is the winner.

It's easy to find words in the WORD CHALLENGE
grid. Look at the sample square on the next page
and connect the letters to form words using the
following rules:

1. Letters may only be connected if they touch
each other on any side or on any corner. For
example, in the sample square, the letter I
adjoins A, L and D.

2. Words are legal only if the letters connect in
sequence. Connecting letters in sequence
means that each new letter must touch the
previous letter in the word. In the sample
square, the word clad is legal. You begin
with C, then L touches C, then A touches L,
then D touches A. However, you may not
spell cling, since the N does not touch the
previous letter 1.

3. The same letter may be used only once in the
construction of a single word. In the
example,you can spell sail, but not sails,
because the letter S would be used twice.

4, Legal words are made up of the combination
of letters A through Z. Apostrophes and
hyphens are not permitted.

5. Words must be at least three letters long to
receive credit. For example, in the sample
square, the word as is not credited. (The
special case Qu, which will appear in one
box, counts as two letters in scoring and
construction.)



SAMPLE SQUARE

You can make 45 words from this simple square.
(Try it.) Here are a few:

snail glanced sale sail dial

To play WORD CHALLENGE, you need a
Macintosh system unit with built-in disk drive,
with at least 128K bytes of memory, keyboard and
mouse.

To load WORD CHALLENGE, simply turn on
your Macintosh, wait until the Macintosh icon
with the flashing “?" appears on the screen, then
insert your WORD CHALLENGE disk into the
drive slot. On the Macintosh, all features are
available on pull-down menus and can be
activated by simply moving and clicking your
mouse. When the dialog box, “"Ready to play”,
appears on your screen, position the arrow on the
Start button and click your mouse.



STANDARD GAME

BEGINNING THE GAME

| & File Edit Options

eadg to play

Make any desired changes to
game options using Options menu,
and click Start button to begin

[ start |

You are now ready to play WORD CHALLENGE.
GOOD LUCK!

WORD CHALLENGE boots with the Game
Options set to the Standard Game Settings. If you
choose not to change any options before
beginning to play, you will be playing WORD
CHALLENGE on a 4 X 4 grid for three minutes.
LEX will be set at difficulty level T on a scale
from A (most difficult) to Z (least difficult), and
the Winning Score is set at 100 points. You may
view the setting of these options by selecting
Options menu and clicking Display Option
Settings.

Start entering your words as soon as the grid of
letters appears on the screen. To enter a word,
use the mouse to position the arrow over the first
letter of the word you are spelling. Hold down
the mouse button and drag it over each letter of
the word in consecutive order. Release the mouse
button when you have chosen the last letter of the
word. Notice that each letter of the word appears
in the “Your Words” box as it is highlighted by
the mouse. You may back up and erase letters if
you have not yet released the mouse.

Words may also be typed in from the keyboard.
Each letter will appear in the “Your Words" box.
Words must be separated by a non-alphabetic
character such as RETURN, SPACE, COMMA or
any other non-alphabetic character you choose. If
you have misspelled a word, you can use the edit
features of your Macintosh to correct it. However,
since there is no penalty for a misspelled word,
and since you are racing against the clock, you
might find it advantageous to simply enter the
word.



DISPLAY WORDS

SPELL WORDS

While YOU and LEX look for words hidden in the
square, the Scorekeeper searches the 90,000
word dictionary to determine all of the possible
words in the square. The Timer posts the number
of seconds remaining in the game on the
scoreboard and visually counts down the
remaining time in the game. When less than one
minute is left, a bar graph appears on the
scoreboard and begins shrinking by the second.
Now the final countdown begins. The Timer
beeps once per second for the last ten seconds of
the game. When time runs out, play stops and the
“Your Words” box is cleared to begin scoring.

SCORING

First Phase

Each word found by either player is shown on the
screen. Next to each word, the Scorekeeper
indicates who found the word by placing a YES
in the YOU column, the LEX column or both.

In the Standard Game, you are given approxi-
mately three seconds to review each word
displayed by the Scorekeeper. During that time,
the Scorekeeper highlights the word in the
square and will trace it out for you, if you hold
down any key on the keyboard.

The Scorekeeper compares your list of words with
LEX's list of words and gives credit as follows:

YOU have the word but LEX does not = You recelve credit.

LEX has the word but YOU do not = LEX receives credit. .
YOU and LEX both have theword = No credit is given.

The exact number of points awarded for each
word depends on the length of the word and the
scoring method you select. Basically, you receive
more points for longer words. (See the Setting
Game Options section for an explanation of
various scoring methods.)



Second Phase

Although the Scorekeeper is very knowledgeable
and knows 90,000 words, you may find a word it
doesn’t know. During the secondary scoring
phase the Scorekeeper displays all uncredited
words and you are given the chance to receive
credit for them.

If you would like to view your uncredited and
unconstructible words, press S. If you would like
to bypass the secondary scoring phase, press C.

During the secondary scoring phase, the
Scorekeeper also displays any words you entered
that could not be constructed in the square.

The score of a game is displayed on the
scoreboard. For each game, the Scorekeeper
displays the number of points earned by YOU
and LEX and the number of points tied. The
number of words in the square and the maximum
number of points available in the square are also
displayed on the scoreboard. The running totals
for a match are displayed at the bottom of the
scoreboard by two bar graphs labeled as follows:

During each game, the match totals are updated
by the Scorekeeper.

A match is a series of games in which YOU and
LEX compete to gain points toward the Winning
Score. The Winning Score may be set to any
number from 1 to 999. In the Standard Game, the
Winning Score is set at 100 points.

The number of games in a match is not preset but
varies with the number of points YOU and LEX
score on each word square. On the final board,
the Scorekeeper continues to update game and
match totals past the Winning Score, giving
credit for all words found by each opponent. The
player who has the most points at the end of a
match — not the one who reaches the Winning
Score first — is declared the winner. Then the
Scoring window clears, the Introductory Display
returns and you are ready to play another match
of WORD CHALLENGE.



EXITING THE GAME To exit WORD CHALLENGE, perform the

following step:

NN
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v+ Pull down the File menu and click Quit.

Remove your disk and store it in a safe place.
Your Macintosh is now ready to insert another
application disk.

SPECIAL FEATURES

The first three special features can be used
during play. They are identified by the three
buttons displayed on the right of the scoreboard
during play and scoring. They are: Rotate Left,
Rotate Right and Start Scoring.

Use this feature to view the current word square
from a different angle. Perform the following step
to rotate the word square to the left.

e Select and click the LEFT button.

The word square rotates counterclockwise.

Perform the following step to rotate the word
square to the right.

e Select and click the RIGHT button.

The word square rotates clockwise.




START SCORING

APPLE MENU

When you have found all the words you can in a
square, select and click the Start Scoring button
on the scoreboard. This will stop the clock and
begin scoring. You do not have to wait for time to
run out to end the game. Note: Scoring cannot
begin until the Scorekeeper has finished
searching through the dictionary. Once you have
selected the Start Scoring button, you cannot
enter any more words.

The remaining features in this section are
arranged by the menu item that controls them,
beginning with the menu item at the far left of
your screen, and proceeding to the right.

A feature is activated by selecting the desired
menu item, dragging the cursor down to the
desired feature, and releasing the mouse button.
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The desk accessories shown on the Apple menu
are all available under WORD CHALLENGE.
See the section on “"Desk Accessories” in the
Macintosh manual (Chapter 4) for a complete
explanation.



FILE MENU

EDIT MENU

Under the File menu is the Quit option. Clicking
Quit cancels the game in progress and ejects the
WORD CHALLENGE disk. Remove your disk and
store it in a safe place. Your Macintosh is now
ready to insert another application disk.

S
Cut and Copy may be used during a WORD
CHALLENGE game to select a word or words
and copy them to another section of the “Your
Words” box. They are also included for use with
the Macintosh Desk Accessories. Paste can be
used to Paste a word into the Scrapbook, which
provides a pathway into MacWrite.



SETTING GAME OPTIONS

WORD CHALLENGE is a very versatile game.
You can determine the character of a game by
changing any of the Standard Game Settings. We
refer to these variable settings as options. This
section of the manual describes each option in

detail.

Standard Possible

Option Setting Settings
Change Difficulty Level T A-Z
List All Words No YorN
Manual Board Entry No YorN
Embedded Words None None, Suffix, or All
Competitive Play No YorN
Change Square Size 4by 4 3.4,0r5
Change Scoring Method B A.B,C.D,orE
Set Score to Win Match 100 pts 1-999
Set Game Timer 180 secs 1-999
Set Display Speed 3 secs 0-5

l Sound On On - Off

For the most part, changing your options
determines the difficulty of the game. As your
vocabulary skills increase, you can play WORD
CHALLENGE at more difficult settings making
WORD CHALLENGE suitable for people of all
ages and skills.

Display option settings
Change difficulty level
List all words

Manual board entry
Embedded words
Competitive play

Change square size

Change scoring method

Set score to win match

Set game timer

Set display speed
vSound

To change a particular setting for any option,
select the Options menu, drag the cursor down
until the desired feature is highlighted, then
release the mouse button. Changing the setting of
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any option on the menu causes the match to be
played under your rules. Once the game is
underway, you cannot access or change any of
the game options.

Clicking this option allows the user to view the
current setting of the game options. The following
menu options allow you to change these settings.

There are 26 difficulty levels at which your
opponent, LEX, can play WORD CHALLENGE.
Level A represents superior playing ability. At
Level A, LEX will find all possible words in the
square. Level Z represents the easiest level of
play. Use the keyboard to enter the level of
difficulty you desire.

At lower levels, LEX is restricted in his
knowledge to words of shorter length and simpler
English construction. At lower levels, LEX is also
restricted in the number of words he can process.
Since changing levels alters both the kind and
amount of words that LEX will find, you can
realistically adjust the ability of your opponent.

'y

D

During the scoring stage of a Standard Game,
the Scorekeeper displays only those words that
YOU or LEX find in the word square. Selecting
the List All Words option allows all possible
words in the square to be displayed, regardless
of whether or not the word was found by YOU or
LEX. The List All Words option allows you to
play competitively with LEX at your own skill
level and still see all of the possible words that
can be constructed in a square.

When the List All Words option is activated, a
check mark will be displayed in front of that
option in the Options menu. To deactivate the
List All Words option, simply select and click the
option again in the Options menu (removing the
check mark).

Selecting the Manual Board Entry option
enables you to create your own square! During
play, a blank word square board will appear on
the screen. You select your letters, one by one,
starting in the upper left-hand corner of the blank
word square board. If you make an error entering
your letters, simply press BACKSPACE until you
have cleared your error and reenter the correct
letter. Before play begins, you will be asked to
verify your board. Click the OK button when the
board is correct. The Manual Board Entry option
enables you to play games from the newspaper
by entering the desired letters.

11



EMBEDDED WORDS

When the Manual Board Entry option is
activated, a check mark will be displayed in front
of that option in the Options menu. To
deactivate the Manual Board Entry option,
simply select and click the option again in the
Options menu (removing the check mark).

WORD CHALLENGE players will notice that it is
possible to enter a word which has one or more
other words contained within it. For example, in
the word strainers, you can find the following
words:

— rain — strain

— train — strainer
— trainer — strainers
— trainers

These words are referred to as embedded words.

During standard play, if you enter the word
strainers you will receive credit for only one
word, strainers. However by selecting the
Embedded Words option, you can receive credit
for some, if not all, embedded words.

By selecting and clicking the SUFFIX button, you
receive credit for all embedded words that begin
with the same letter sequence as your original
word. So if you enter strainers, you would
receive credit for:

— strain
— strainer
— strainers

However, you would not receive credit for any
embedded word that does not begin with the
same first three letters of your entry. This is
called SUFFIX mode because you are receiving
the root word(s) free without using the additional
time needed to enter them into the game.

By selecting and clicking the ALL button, you
receive credit for all words embedded in the
original word. For the word strollers, you would
receive credit for the following:

— roll — trollers
— roller — stroller
— rollers — strollers
— troll

WORD CHALLENGE players who just don't have
enough time to enter every word they find, will
learn to love this option.

12



COMPETITIVE PLAY

CHANGE SQUARE SIZE

CHANGE SCORING
METHOD

The Competitive Play option allows you to
reproduce a square you have already played. If
LEX is playing at the same difficulty level each
time, even his responses will be reproducible!

Select and click the Competitive Play option,
then enter the board number you wish to replay
in the dialog box and click the YES button.
Clicking the YES button without entering a board
number automatically draws a new board on your
screen with an assigned number. The board
number appears on the scoreboard. This way if
you want to replay the new board, remember the
number assigned to it and select the Competitive
Play option at the end of your game.

There are 65,536 distinct competition boards
available for each square size. If you wish to
replay a specific board in Competitive Play,
simply enter the number of the desired board.
You will notice that there is a slightly different
board for each number depending on the size of
the grid. If your option settings are the same as
before, WORD CHALLENGE will reproduce the
previous game exactly.

The Competitive Play option is used primarily
by those who wish to use the Scorekeeper as a
referee between two competitors playing the
same square against LEX or the same player
playing the same square against LEX at different
times. See if you can beat LEX at a certain level.
When you have mastered that level, increase the
level of difficulty and replay your sequence of
boards to determine your progress.

To change the size of the word square grid,
select and click the Change Square Size option
from your Options menu. Then select and click
one of the three buttons on the dialog box to
indicate the size you want. A 3 X 3 word square
grid is the easiest square to play. A 4 X 4 grid is
the standard size and the 5 X 5 grid is the most
difficult to play.

Choose among five Scoring Methods. Use the
method recommended for each board size. The
methods available to you are alike in three
aspects:

l. The scoring method chosen is used to add up
both your points and LEX's.

13



2. Any words found by both YOU and LEX are
not credited.

3. One and two letter words are not credited.
Each scoring method has a specific task for

which it is best suited.

Scoring Method A
Recommended for use with 3 x 3 board.

Wordlength | 0-2[3|4|S|6|7 [8-up i
Points 0 |1]2{4]7[10] 12

SV

Scoring Method B
Recommended for use with 4 x 4 board.

Wordlength | 0-2|3—4 |5
| Points 0 1 |2

Scoring Method C
Recommended for use with 5 x 5 board.

Wordlength {0-3 |4 |5 |6 [7[8]9({10[11-uplg
Points 0 11213]4(6(8]10 II

Scoring Method D

This method of scoring rewards longer words.
You receive one point for each letter in any
word.

Scoring Method E

This method of scoring rewards the most words.
You receive one point for each word found,
regardless of length. Hint: When using this
scoring method, concentrate on finding short
words. The more words you find, the more points
you accumulate!

14



T SCORE TO WIN
CH

The Winning Score determines when a match is
over and may be changed to any number from 1
to 999 points. Use the keyboard to select the
number of points and click the OK button after
entering your numbers.

The Timer limits, in seconds, the amount of time
you have to play a WORD CHALLENGE game.
The Timer can be set to any number of seconds
ranging from 1 to 999 seconds. You will usually
want to allow more than 3 minuteson 5 X 5
squares, but less than 3 minutes on 3 x 3
squares. Use the keyboard to select the number
of seconds and click the OK button in the dialog
box after entering your numbers.

At the end of each game, the Scorekeeper
displays each word that is found in the word
square and pauses between them to allow each
word to be examined. The Display Speed
determines how long the Scorekeeper pauses.
Setting this option to 5 allows the longest pause.
You may ask the Scorekeeper to trace out each
letter of a word by holding down any key during
scoring. This will extend the amount of time for
which a word is displayed.

Selecting the Sound option provides sound
during the last ten seconds of the game. In
addition, if you ask to have words traced out
during scoring (by holding down any key), each
letter will flash and play a musical note.

When the Sound option is activated, a check
mark will be displayed in front of the word
Sound in the Options menu. To turn the sound
off, simply select and click the Sound option in
the Options menu (removing the check mark).

15



STRATEGY AND THE DICTIONARY

The dictionary used in WORD CHALLENGE is a
very specialized word list. It presents an accurate
description of the English language and can be a
significant tool in improving your vocabulary.

LEX is, undisputably, an expert. You will learn
new words from LEX and improve your spelling
skills. The dictionary your opponent uses
includes many everyday words that you will
easily recognize plus new terms that have
recently been incorporated into English. Many of
these new words still do not appear in the best
paper-bound dictionaries! However, you can
improve your game by knowing a few facts about
the types of words in the WORD CHALLENGE
dictionary.

Words with suffixes make up a large portion of
the dictionary. Words that end in -ing, -ly, -er,
-ers and -ness account for more than 21,000
entries!

If you find a common root word like help, spend
some time looking for some of its variants like
helps, helped, helping and helper. You'll be
surprised at the mileage you can get out of a
single root word by adding suffixes, if the letters
are available in the grid.

Every letter of the alphabet has a different
number of words in its section of the dictionary.
Far more words begin with the letters ¢ and s
than with any other letter. Words that begin with
¢ and words that begin with s constitute more
than one-fifth of the dictionary. In contrast to
this, the letters j, k, n, q, v, x, y, and z
combined, account for less than six percent.

Even though the English language does not treat
all letters equally, the WORD CHALLENGE
Scorekeeper does! So, try spending more time
working with common letters like ¢ and s, than,
for instance, a more exotic letter like x. While
words with x like axolotl, calyx and xebec may
seem intriguing, they account for less than three
percent of the dictionary.

The following chart indicates the approximate
number of times each letter of the alphabet
appears in the dictionary.

16



TIME SAVING TIP

Number Number -

Letter | Occurrences | Letter Occurrences %
a 59.5 n 56.0 §
b 15.2 o 47.3 %
c 32.6 p 2.6 F
d 27.8 q 1.5 F
€ 93.1 r 58.4 g%
f 10.7 s 73.3 ?ﬁ
g 22.4 t 56.8 ||
h 16.6 u 25.1 %
[ 5.3 v 8.5 ||
i 1.2 w 5.9 g&?
k 6.0 X 2.3 %
I 45.3 y 14.6 E.
m 21.3 P4 3.9 §

Occurrences represented in thousands.

There are many long words in the WORD
CHALLENGE dictionary, if you can only find
them! Over half of the words in the dictionary are
between seven and ten letters long. The average
word has eight letters and the longest entry has
twenty-four. The longest word in the English
language has forty-five letters! It is
pneumonoultramicroscopicsilicovolcanoconiosis.

Since each letter on a WORD CHALLENGE
board can only be used once while forming a
word, there is no need to have entries quite this
long in the dictionary. Our longest entry is
transubstantiationalists. By forming just one word
over seven letters long, you can add at least six
points to your game score. So, work with the
letter combinations you find in each square to
form longer words. Once you've found one word,
try finding its variants. By adding a simple
ending, you can transform a short word into a
high scorer.

Try switching letters’ positions and see what new
words can be made. You can gain easy points by
utilizing a small set of letter combinations.

Let WORD CHALLENGE do some of the work for
you, with the Embedded Words option. You'll
work less and gain points!

Try out these strategies. . .
GOOD LUCK and HAVE FUN!
17



INSIDE WORD CHALLENGE

STORING 90,000
WORDS

If you have been wondering how WORD
CHALLENGE works, here is a general overview.
The WORD CHALLENGE dictionary is structured
in a special manner, so that it is stored
economically and can easily be searched by the
WORD CHALLENGE Scorekeeper.

One of the great challenges faced in developing
WORD CHALLENGE was to make the entire
dictionary small enough so that it could be used
on a personal computer. Normally, to store a list
of words on a disk, every character of each word
would require a single byte of storage and the
end of each word would be marked by the
presence of a special byte. For example, the
word run would require four bytes, one for each
character and one to indicate the end of the
word. An interesting fact is, using the average
length of a word in the WORD CHALLENGE
dictionary, you would need more than 800,000
bytes of storage, which would take up five of
these disks!

A compression scheme was engineered that
shrunk this list of words so that it could fit onto
one disk (the dictionary occupies only 93K
bytes!). The secret of this amazing compression is
the English language itself. In English, many
words are formed by adding endings to a smaller
set of common root words. For example, a
common verb like fouch is the basis of a large
family of words which are created by adding
suffixes like -es, -ed and -ing. Here is a list of the
many words that can be traced back to the root
word touch:

touch touchy
touches touchier
touched touchiest
touching touchily
touchingly touchiness
toucher touchless
touchers touchable

One trick to compresing this list of words was to
store the root word fouch only once, then
indicate by code what valid endings it could
take. The result is a very compact but exhaustive
list of words!
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Just as most printed dictionaries are
alphabetically ordered and include breaks for
each letter of the alphabet, the WORD
CHALLENGE dictionary is an alphabetic list
divided into sections. A high speed search is
conducted through the dictionary to find words
that are hidden in each board.

When a board is drawn, the Scorekeeper
systematically searches for viable two-letter
combinations which can begin words. Once a
combination is found, the Scorekeeper examines
the letters around the combination to find a third
letter it can add on. It continues to build words,
letter by letter, constantly scanning through the
dictionary looking for matches. Once it has
exhausted one three-letter combination and found
all the words it leads to, the Scorekeeper returns
to the initial two-letter combination it found. It
then looks for a new third letter to add on which
will lead to a new avenue of valid letter
combinations and words.

The Scorekeeper delivers words to LEX which
agree with the level of difficulty selected. Each
difficulty level reflects a realistic adjustment in
linguistic intelligence. So, while LEX will find
words such as ice and wig playing at level T,
LEX will not find more complicated words such
as cede and geode which would be found at a
higher level of play. LEX's ability can be
adjusted so that an adult and a third grader
could each play the same board and find it
competitively challenging.

The words you enter are simply compared against
the Scorekeeper’s list. If the Scorekeeper does
not have the word, then the dictionary does not
include the entry. However, you are given the
option of receiving credit for words that are not
on the Scorekeeper’s list at the end of a game.

Now that you know how the Scorekeeper and LEX
operate, try a new game!
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